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Wichtige Informationen
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lediglich „wie gesehen“ zur Verfügung gestellt. In keinem Fall kann Texas Instruments
für Schäden haftbar gemacht werden, die sich entweder in Verbindung mit dem Kauf
bzw. Gebrauch dieses Produkts ergeben oder dadurch verursacht werden, dies gilt für
spezielle, begleitende und versehentliche Schäden sowie für Folgeschäden. Texas
Instruments haftet maximal und ausschließlich in der Höhe des Kaufpreises des
Produkts, unabhängig vom jeweiligen Fall. Weiterhin haftet Texas Instruments nicht für
Forderungen einer anderen Partei, die sich aus dem Gebrauch dieses Produkts ergeben,
welcher Art diese Forderungen auch immer sein mögen.

Diese wissenschaftliche Produkt-Applikation (APP) ist lizenziert. Siehe Bedingungen der
Lizenzvereinbarung.

Copyright © 2025 Texas Instruments Incorporated

Die aktuellen Produkte können geringfügig von den Abbildungen abweichen.
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1 Anmelden mit Ihrem TI-Konto

Anmelden mit Ihrem TI-Konto
Um die TI-SmartView™ Emulator-Software für MathPrint™ Taschenrechner verwenden
zu können, müssen Sie sich an Ihrem TI Konto anmelden.

1. Starten Sie die TI-SmartView™ Emulator-Software für MathPrint™ Taschenrechner.

Wenn Sie die Software zum ersten Mal starten, werden Sie aufgefordert, die Lizenz,
die Datenschutzrichtlinie und die Online-Nutzungsbedingungen zu akzeptieren.

Klicken Sie auf Accept.

2. Klicken Sie in der Anmeldeaufforderung auf LAUNCH SIGN IN.

Hinweis: Wenn Sie eine Einzelbenutzerlizenz erwerben möchten, klicken Sie auf
PURCHASE LICENSE.

Dadurch wird die Anmeldeseite von Texas Instruments in Ihrem Browser geöffnet.
Schließen Sie den Anmeldevorgang mit einem Google-Konto oder mit der mit Ihrem
TI-Konto verbundenen E-Mail-Adresse ab.



Nach der Validierung Ihres Kontos wird eine Erfolgsmeldung im Browser angezeigt
und die Software wird geöffnet.

Lizenzinformationen anzeigen

Wenn Sie angemeldet sind, können Sie die Details Ihrer Lizenz einsehen.

▶ Gehen Sie zu Help > License Info.

Account Info: E-Mail-Adresse des aktuellen Benutzers.

Subscription Expiration: Ablaufdatum der aktuellen Software-Lizenz.

Session Expiration: Verbleibende Zeit in der aktuellen Sitzung.

Während die Software benutzt wird, stellt sie alle 15 Minuten eine Verbindung mit
dem Lizenzierungssystem her. Wenn der Benutzer zu irgendeinem Zeitpunkt offline
geht, läuft die Software noch sieben Tage lang ab dem Zeitpunkt der letzten
Verbindung.

Abmelden von Ihrem Konto

1. Gehen Sie zu Help > Sign Out.

2. Klicken Sie auf SIGN OUT.

Die Software wird geschlossen und eine Browser-Registerkarte öffnet die
Anmeldeseite.

Bei der Abmeldung wird der aktuelle Status gespeichert und die Lizenz wieder in
den Pool der verfügbaren Plätze zurückgegeben. Wenn die Software über File > Exit
oder die Schaltfläche „Schließen“ geschlossen wird, wird der Benutzer nicht
automatisch abgemeldet und die Lizenz freigegeben.
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3 Einführung in die TI-SmartView™ Emulator-Software für MathPrint™ Taschenrechner

Einführung in die TI-SmartView™ Emulator-Software für
MathPrint™ Taschenrechner
Die TI-SmartView™ Emulator-Software für MathPrint™ Taschenrechner ermöglicht die
Darstellung eines wissenschaftlichen Taschenrechners von TI für alle Schüler im
Klassenzimmer.

Arbeitsbereich Taschenrechner-Emulator

für folgende Tätigkeiten:

• Emulator auswählen
– Wählen Sie einen Emulator aus, mit dem Sie arbeiten möchten.

– TI-30X Plus MathPrint™
– TI-30X Pro MathPrint™
– TI-30X Prio MathPrint™
– TI-30XB MultiView™
– TI-30XS MultiView™
– TI-34 MultiView™

• Große Emulatoransicht ausblenden/anzeigen
– Sie können die ganze Emulatoransicht mit oder ohne Fensterbereich

für die vergrößerte Darstellung anzeigen.
• Tastenfolge ausblenden/anzeigen

– Zeigt die gedrückten Tasten, damit die Schüler sie nachvollziehen
können.

• Öffnen eines separaten Screenshot-Fensters
– Erfassen und speichern Sie Emulator-Screenshots als

Computerdateien, ähnlich wie mit TI Connect™ CE Screen Capture.

Siehe: Verwenden des Arbeitsbereichs des Taschenrechner-Emulators zur Verbesserung
Ihrer Klassenzimmer-Präsentationen.

Auswahl Des Emulatortyps
Beim ersten Start von TI-SmartView™ für MathPrint™ auf Ihrem Computer wird ein
Benachrichtigungs-Dialogfeld angezeigt.



Wählen Sie Ihren Emulatortyp über das
Pulldown-Menü und wählen Sie dann OK.
Der gewählte Emulator wird für die erste
Präsentation angezeigt.

TI-SmartView™ für MathPrint™ wird bei einem erneuten Start des Programms immer in
dem Zustand ausgeführt, in dem es sich beim letzten Beenden befunden hat. Nach dem
Start der Software können Sie den Standard-Emulator ändern.

Siehe:Auswählen eines Emulatortyps

Der zuletzt angezeigte Emulatortyp wird zum Standard-Emulator und die
Fenstergröße wird so angezeigt, wie Sie sie zuletzt eingestellt hatten.

Siehe: Ändern der Größe des Fensterbereich für die vergrößerte Darstellung des TI-
SmartView™ Emulators
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5 Einführung in die TI-SmartView™ Emulator-Software für MathPrint™ Taschenrechner

Bildschirm des Taschenrechner-Emulators

Hinweis: Die Bilder in diesem Handbuch können je nach ausgewähltem Emulator
unterschiedlich sein.



Verwenden des TI-SmartView™ Emulator-
Arbeitsbereichs für MathPrint™ Taschenrechner
Der TI-SmartView™ Emulator-Arbeitsbereich für den MathPrint™ Taschenrechner
enthält Werkzeuge, die Sie zur Eingabe von Berechnungen verwenden können.
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7 Verwenden des TI-SmartView™ Emulator-Arbeitsbereichs für MathPrint™ Taschenrechner

Teile des TI-SmartView™ Emulator-Arbeitsbereichs

Menüleiste - Über diese Menüs führen Sie alle Funktionen des Emulators aus,
einschließlich:

• File (Datei – beenden oder
abbrechen • Actions (Aktionen) – z. B. Screenshot

• Edit (Bearbeiten) – z. B.
Tasten als Text in einer
speziellen Schriftart
kopieren

• Help (Hilfe) – Hilfe und Links

• View (Ansicht) – Ändern der
Ansicht

Hinweis: Die meisten Aktionen in diesen Menüs können Sie durch Anklicken von
Symbolen in der Symbolleiste abschließen.

Symbolleiste – Mit den Symbolen in der Symbolleiste können Sie folgende
Tätigkeiten durchführen:
• Auswählen eines anderen Taschenrechnermodells
• Umschalten zwischen vergrößerter Darstellung und Ein-/Ausschalten der

Chronik der Tasteneingaben
• Erfassen des aktuellen Emulator-Bildschirms

Festlegen der Position von Emulator und Symbolleiste

• Emulatorposition links/rechts – Umschalten zwischen Anzeige des
Taschenrechner-Displays links/rechts auf dem Bildschirm. Dies ist praktisch
bei der Präsentation auf einem interaktiven Whiteboard.

• Symbolleiste oben/unten – Umschalten zwischen Anzeige der
Symbolleiste oben oder unten auf dem Bildschirm. Dies ist praktisch bei der
Präsentation auf einem interaktiven Whiteboard.

Hinweis: Besonders bei der Arbeit mit einem interaktiven Whiteboard können
Sie die Anordnung der Elemente für eine möglichst leichte Bedienung
optimieren.

Emulator-Fensterbereich – In diesem Fensterbereich können Sie entweder den
vollständigen Emulator oder nur die Tastaturansicht anzeigen.

Fensterbereich für die vergrößerte Darstellung/Fensterbereich für die Chronik der
Tasteneingaben – In diesem Fensterbereich können Sie eine vergrößerte
Darstellung des Taschenrechner-Bildschirms und/oder eine Chronik der
Tasteneingaben anzeigen.



Die folgenden Anzeige-Optionen stehen Ihnen zur Verfügung:

• Nur vergrößerte Darstellung • Nur Chronik der Tasteneingaben
• Vergrößerte Darstellung +

Chronik der Tasteneingaben
• Bildschirm für die vergrößerte

Darstellung ausblenden

Größe der Fensterbereiche ändern – Klicken Sie auf eine vertikale Kante eines
Fensterbereichs und ziehen Sie, um dessen Größe zu ändern.

Verwenden der TI-SmartView™ Emulatortastatur
Anstelle die Tasten am Taschenrechner mit den Fingern zu drücken, verwenden Sie in
der Emulator-Software den Mauszeiger.

Klicken Sie mit der Maus auf die Taschenrechnertasten im TI-SmartView™ Emulator für
MathPrint™, wie Sie die Tasten am Taschenrechner drücken würden.

Halten Sie eine Pfeiltaste gedrückt, um kontinuierlich zu scrollen.

Wenn Sie den Cursor mit einer Pfeiltaste bewegen und die Taste gedrückt halten, wird
kontinuierlich gescrollt, sodass Sie die Taste nicht mehrmals drücken müssen. Im
Tastenfolgenfenster ist das Symbol für eine solche Pfeiltaste mit einem Uhrsymbol
gekennzeichnet.

Wenn Sie eine Pfeiltaste mehrmals hintereinander drücken, wird ein Pfeil mit einem
Zähler angezeigt.

Wenn Sie eine Pfeiltaste mehrmals hintereinander drücken, wird in der Chronik der

Tasteneingaben eine Pfeiltaste angezeigt; an dieser Pfeiltaste befindet sich eine
Zahl, die angibt, wie oft die Pfeiltaste gedrückt wurde.

Ziehen und Ablegen eines Bildschirms in einer anderen Anwendung
Sie können einen Bildschirm aus dem TI-SmartView™ Emulator für MathPrint™
Taschenrechner auf eine andere Anwendung ziehen, um ihn dort einzufügen.

Zu den Bildschirmen des TI-SmartView™ Emulators für MathPrint™ Taschenrechner, die
Sie verschieben und einfügen können, gehören:

• Der Bildschirm über der Tastatur im Emulator-Fensterbereich

• Die vergrößerte Darstellung

• Gespeicherte und nicht gespeicherte Screenshots im Arbeitsbereich „Screen
Capture“ (Schnappschuss)
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9 Verwenden des TI-SmartView™ Emulator-Arbeitsbereichs für MathPrint™ Taschenrechner

Zurücksetzen des Emulators
So setzen Sie den Emulator zurück:

1. Klicken Sie auf Actions (Aktionen).

2. Klicken Sie auf Reset Emulator (Emulator zurücksetzen).

3. Klicken Sie auf Reset (Zurücksetzen).

Zurücksetzen des Emulators:

• Überschreibt den aktuellen Emulatorstatus

• Löscht die Chronik der Tasteneingaben



Speichern und Laden eines MathPrint™ Emulators Status
Wenn Sie den Status des MathPrint™ Emulators speichern, wird eine Datei erstellt, in
der die Emulatoreinstellungen mit allen vorgenommenen Änderungen enthalten sind.

Angenommen, Sie richten für eine Klasse eine Präsentation ein, bei der Sie Daten in
einen Dateneditor und Funktionen in f(x) und g(x) eingeben. Wenn Sie diese
Änderungen in einer Emulatorstatusdatei speichern, können Sie die Datei für die
Präsentation später jederzeit wieder laden. Wenn Sie verschiedene Präsentationen für
unterschiedliche Klassen vorbereiten wollen, erstellen Sie einfach mehrere
Emulatorstatusdateien.

Hinweis: Die Chronik der Tasteneingaben, Bildschirmabbildungen, die Emulatoransicht
und die Emulatorgröße werden nicht in der Emulatorstatusdatei abgelegt. Bitte
beachten Sie, dass die MathPrint™ Emulatorstatusdatei relativ groß sein kann. Wenden
Sie sich bei Problemen mit Ihrer Speicherkapazität bitte an Ihre IT-Abteilung.

Speichern des MathPrint™ Emulatorstatus

Das Verwalten, Speichern und Laden eines Emulatorstatus ist für jeden MathPrint™
Emulator möglich. Die Emulatorstatusdatei für TI-30X Plus MathPrint™ kann nur im TI-
30X Plus MathPrint™ Emulator geladen werden.

Hinweis: Der TI-30X Pro MathPrint™ Emulatorstatus kann nur im TI-30X Plus
MathPrint™ Emulator geladen werden.

1. Klicken Sie auf Actions > Save Emulator State... (Aktionen > Emulatorstatus
speichern...).

2. Im Dialogfeld:

Verwenden des TI-SmartView™ Emulator-Arbeitsbereichs für MathPrint™ Taschenrechner 10



11 Verwenden des TI-SmartView™ Emulator-Arbeitsbereichs für MathPrint™ Taschenrechner

a) Navigieren Sie zu dem Ordner, in dem die MathPrint™ Emulatorstatusdatei
gespeichert werden soll.

b) Geben Sie einen Dateinamen ein. Verwenden Sie einen Namen, der den
MathPrint™ Emulatorstatus beschreibt.

Hinweis: Die MathPrint™ Emulatorstatusdateien besitzen einen
vorkonfigurierten Dateinamen mit der Erweiterung *.s3l, die angibt, dass es
sich hierbei um einen von der TI-SmartView™ MathPrint™ Emulator-Software
erstellten TI-30X Plus MathPrint™ Taschenrechner-Emulatorstatus handelt. Die
Erweiterung für den TI-30X Pro MathPrint™ Taschenrechner-Emulatorstatus ist
*.s3r. Die Erweiterung für den TI-30X Prio MathPrint™ Taschenrechner-
Emulatorstatus ist *.s3i.

c) Klicken Sie auf Save (Speichern).

Laden eines MathPrint™ Emulatorstatus

Da die MathPrint™ Emulatorstatusdateien modellspezifisch sind, können Sie nur
Emulatorstatusdateien für das gerade aktive Rechnermodell laden.

1. Klicken Sie auf Actions > Load Emulator State (Aktionen > Emulatorstatus laden).

2. Im Dialogfeld:

a) Navigieren Sie zu dem Ordner, in dem die Emulatorstatusdatei gespeichert ist.

Hinweis: Es werden nur die MathPrint™ Emulatorstatusdateien für das aktive
Rechnermodell angezeigt.

b) Klicken Sie auf den Namen des MathPrint™ Emulatorstatus, um ihn zu
markieren.

c) Klicken Sie auf Öffnen.



Auswählen einer Anzeigeoption
Sie können optionale Fensterbereiche anzeigen bzw. ausblenden und festlegen, welche
Informationen darin angezeigt werden sollen. Standardmäßig zeigt die TI-SmartView™
Emulator-Software für MathPrint™ Taschenrechner den Arbeitsbereich des
Taschenrechner-Emulators in der vergrößerten Darstellung an.

Anzeige des Taschenrechner-Bildschirms

1. Klicken Sie auf ,
um die vergrößerte
Darstellung
auszublenden.

2. Klicken Sie erneut auf , um die vergrößerte
Darstellung
anzuzeigen.

Auswählen eines Emulatortyps

Klicken Sie bei auf den Abwärtspfeil, um einen Emulatortyp auszuwählen.

Verwenden des TI-SmartView™ Emulator-Arbeitsbereichs für MathPrint™ Taschenrechner 12



13 Verwenden des TI-SmartView™ Emulator-Arbeitsbereichs für MathPrint™ Taschenrechner

Für jeden Emulatortyp wird das zugehörige Taschenrechnermodell angezeigt.

Ändern des Taschenrechner-Frontcovers

So ändern Sie das Frontcover:

1. Klicken Sie auf View (Anzeigen).

2. Bewegen Sie die Maus auf Calculator Faceplate (Taschenrechner-Frontcover).

3. Klicken Sie auf den Namen des Taschenrechner-Frontcovers.

Hell Dunkel Umriss



Anzeigen und Ausblenden der Chronik der Tasteneingaben

Klicken Sie auf , um die Chronik der Tasteneingaben ein- bzw. auszublenden.
Klicken Sie auf CLEAR (LÖSCHEN) im Fensterbereich neben der Chronik der
Tasteneingaben, um den Verlauf zu löschen.

Klicken Sie hier
und ziehen Sie die
Maus, um die
Größe des
Fensterbereichs zu
ändern, in dem die
Chronik der
Tasteneingaben
angezeigt wird.

Klicken Sie
hier,
nachdem Sie
die Tasten
zum Kopieren
der Schriftart
als Grafik
ausgewählt
haben.

Klicken Sie hier,
um die
Chronik der
Tasteneingaben zu
löschen.

Wenn Sie „Clear“ (Löschen) drücken, wird das folgende Informationsfeld angezeigt:

Kopieren der Chronik der Tasteneingaben in eine andere
Anwendung
Sie können den Inhalt der Chronik der Tasteneingaben ganz oder teilweise in eine
andere Anwendung wie ein Textverarbeitungsprogramm kopieren. Dabei können die

grafischen Tastendarstellungen , die in der Chronik der Tasteneingaben angezeigt
werden, oder die Tastenanschläge als Textzeichen2U3 kopiert werden.

Hinweis: Wenn Sie Schlüssel als Schriftartzeichen kopieren, werden nur primäre
Schlüsselschriftarten eingefügt. Schriftarten sekundärer Tastenfunktionen lassen sich
nicht über die Funktion „Copy As Font“ (Als Textzeichen kopieren) in TI-SmartView™

Verwenden des TI-SmartView™ Emulator-Arbeitsbereichs für MathPrint™ Taschenrechner 14



15 Verwenden des TI-SmartView™ Emulator-Arbeitsbereichs für MathPrint™ Taschenrechner

einfügen. Die 2nd-Funktionen können mit der installierten Schriftart manuell eingefügt
werden. Diese Schriftart wird bei der Installation der TI-SmartView™ Software für
MathPrint™ Taschenrechner automatisch auf dem Computer installiert.

Kopieren von Tasten als Grafik oder Textzeichen

1. Markieren Sie die Taste(n), die kopiert werden sollen.
Wählen Sie eine der folgenden Methoden, um Tasten im Fensterbereich „Key Press
History“ (Chronik der Tasteneingaben) auszuwählen:

Taste Methode

– Eine einzelne Taste: Klicken Sie auf eine Taste.

– Mehrere Tasten: Klicken Sie auf eine Taste.
Halten Sie auf Ihrer Computertastatur
Strg gedrückt.
Klicken Sie auf andere Tasten, um
mehrere Tasten auszuwählen.

– Mehrere aufeinander folgende
Tasten:

Klicken Sie auf eine Taste.
Halten Sie auf Ihrer Computertastatur
die Umschalttaste gedrückt.
Drücken Sie eine andere Taste.
Hinweis: Hierdurch wählen Sie diese
beiden Tasten sowie alle Tasten
zwischen den beiden Tasten aus.

– Alle Tasten: Klicken Sie auf eine Taste.
Führen Sie einen Rechtsklick aus.
Klicken Sie auf Select All (Alles
auswählen).

Hinweis: Die nachstehende Grafik zeigt, wie eine Taste aussieht, bevor und
nachdem Sie sie ausgewählt haben.

Vorher: Nachher:

2. Tasten auswählen

3. Klicken Sie auf Edit>Copy (Bearbeiten>Kopieren), um die Tasten als Grafik zu
kopieren

oder

Klicken Sie auf Edit>Copy As Font (Bearbeiten>Als Textzeichen kopieren), um Tasten
als primäre Textzeichen (2U3) zu kopieren.

4. Wechseln Sie zu einer anderen Anwendung.



5. Fügen Sie die Tasten an der gewünschten Stelle ein.

Hinweis:

• Sie können die ausgewählten Tasten auch als Grafik in die andere Anwendung
ziehen.

• Nachdem Sie die Tasten als Grafik in eine andere Anwendung kopiert oder gezogen
haben, können Sie dort ihre Größe ändern.

• In manchen Anwendungen werden die eingefügten Zeichen möglicherweise in der
Schriftart angezeigt, die an der jeweiligen Stelle gilt. In diesem Fall sind sie
möglicherweise nicht als Tasten des wissenschaftlichen Taschenrechners zu
erkennen. Wenden Sie bei Bedarf die entsprechende Schriftart für den
Rechnerschlüssel auf die Zeichen an. Nähere Informationen zum Formatieren der
Zeichen finden Sie in der Hilfedatei der jeweiligen Zielanwendung.

Verwenden des TI-SmartView™ Emulator-Arbeitsbereichs für MathPrint™ Taschenrechner 16



17 Verwenden des TI-SmartView™ Emulator-Arbeitsbereichs für MathPrint™ Taschenrechner

Ändern der Größe des Fensterbereich für die vergrößerte
Darstellung des TI-SmartView™ Emulators
Klicken Sie auf eine Kante des Fensterbereichs für die vergrößerte Darstellung und
verschieben Sie sie, um die Größe des Fensterbereichs zu ändern.

Hinweis: Die Möglichkeit zur Größeneinstellung bezieht sich bei all diesen
Fensterbereichen auf deren Breite, ausgenommen die Chronik der Tasteneingaben, bei
der die Höhe geändert wird.

Position des Emulators und der Symbolleiste
Emulatorposition links/rechts – Umschalten zwischen Anzeige des
Taschenrechner-Displays links/rechts auf dem Bildschirm. Dies ist
praktisch bei der Präsentation auf einem interaktiven Whiteboard.

Symbolleiste oben/unten – Umschalten zwischen Anzeige der
Symbolleiste oben oder unten auf dem Bildschirm. Dies ist praktisch bei
der Präsentation auf einem interaktiven Whiteboard.



Immer im Vordergrund
Wählen Sie diese Option im Menü „View“ (Ansicht), um das Fenster des TI-SmartView™
Emulators für MathPrint™ Taschenrechner immer vor anderen geöffneten
Softwarefenstern anzuzeigen. Dies entspricht einem Taschenrechner, der auf Ihrem
Schreibtisch immer auf Ihren Papieren liegt. Verschieben Sie das Fenster auf Ihrem
Computerbildschirm so, dass die Anzeige anderer Fenster durch die Option „Always in
Front“ (Immer im Vordergrund) möglichst wenig gestört wird.

Um die Option „Always in Front“ (Immer im Vordergrund) auszuschalten, wählen Sie
den Menüpunkt im Menü „Ansicht“ ab. Für diese Funktion gibt es außer dem Häkchen
im Menü bei aktivierter Funktion kein Symbol in der Symbolleiste und keine weitere
Anzeige.

Hinweise:

Die Fenster für Arbeitsbereich und Schnappschuss des TI-SmartView™ Emulators für
MathPrint™ Taschenrechner werden beide immer im Vordergrund angezeigt und je
nach Position umgeschaltet.

„Always in Front“ (Immer im Vordergrund) sollte nicht in der Vollbild-Ansicht
verwendet werden, da sonst alle anderen Fenster von der Vollbildansicht des TI-
SmartView™ Emulators für MathPrint™ Taschenrechner verdeckt werden.

Verwenden des TI-SmartView™ Emulator-Arbeitsbereichs für MathPrint™ Taschenrechner 18
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Verwenden von Bildschirmaufnahmen
Mit dem Screenshot-Tool des TI-SmartView™ Emulators für MathPrint™
Taschenrechner können Sie den aktuellen Bildschirm des wissenschaftlichen
Taschenrechners erfassen.

So verwenden Sie die Screenshot-Funktion:

▶ Klicken Sie in der Symbolleiste auf .

Das folgende Fenster wird angezeigt:



Teile des Screenshot-Arbeitsbereichs

Erfassen Klicken Sie hier, um den angezeigten Emulatorbildschirm zu
erfassen.
Aktionen > Screenshot
Hinweis: Jedem Bild wird automatisch bei der Erfassung ein
Rahmen hinzugefügt. Sie können diesen jedoch entfernen,
indem Sie auf Ansicht > Screenshot-Rahmen ausblenden
klicken. (Bei mehreren vorhandenen Bildern wird in diesem
Fall der Rahmen von allen Bildern entfernt.)
Mit der Screenshot-Funktion können Sie:
• bis zu 44 Bildschirme gleichzeitig erfassen, (um weitere

Bilder zu erfassen, löschen Sie Bilder im Screenshot-
Fenster)

• Screenshots automatisch speichern, bis Sie das
Hauptfenster von TI-SmartView™ für MathPrint™
Taschenrechner schließen.

Beim Schließen der Screenshot-Funktion wird eine
Eingabeaufforderung angezeigt, in der Sie Ihre Screenshots
speichern können. Sie können während einer Sitzung in TI-
SmartView™ für MathPrint™ Taschenrechner eine neue
Screenshot-Sitzung starten.

Sichern Klicken Sie hier, um die ausgewählten Screenshots zu
speichern.
Datei > Speichern unter

Copy Klicken Sie hier, um ausgewählte Screenshots in die
Zwischenablage zu kopieren.
Bearbeiten > Kopieren

Löschen Klicken Sie hier, um die ausgewählten Screenshots zu
speichern.
Datei > Speichern unter

Größe ändern Verschieben Sie den Punkt auf der Leiste, um die Größe der
Vorschau des aktuellen Screenshots zu ändern.
Ansicht > Screenshots skalieren
Hinweis: Bildschirme werden in der eingestellten Größe
gespeichert.

Umbenennen Sie können einen Screenshot umbenennen, indem Sie den
Namen markieren und einen neuen Namen eingeben.

View Hier können Sie Screenshots anzeigen.

Ziehen und Ablegen eines Bildschirms in einer anderen Anwendung
Sie können einen Bildschirm aus dem TI-SmartView™ Emulator für MathPrint™
Taschenrechner auf eine andere Anwendung ziehen, um ihn dort einzufügen.

Verwenden von Bildschirmaufnahmen 20



21 Verwenden von Bildschirmaufnahmen

Zu den Bildschirmen des TI-SmartView™ Emulators für MathPrint™ Taschenrechner, die
Sie verschieben und einfügen können, gehören:

• Der Bildschirm über der Tastatur im Emulator-Fensterbereich

• Die vergrößerte Darstellung

• Gespeicherte und nicht gespeicherte Screenshots im Arbeitsbereich „Screen
Capture“ (Schnappschuss)



Tastenkürzel auf der Computertastatur
Anstatt Tasten auf der Tastatur-Abbildung des TI-SmartView™ Emulators zu drücken,
können Sie auch eine Taste auf Ihrer Computertastatur drücken.

Verwenden der Computertastatur
Die nachstehende Tabelle listet auf, mit welcher Taste der Computertastatur die
entsprechende Emulator-Taste betätigt wird.

• TI-30X Pro MathPrint™ or TI-30X Plus MathPrint™ tastenkombinationen

• TI-30X Prio MathPrint™ tastenkombinationen

• TI-30XS-30XB MultiView™ tastenkombinationen

• TI-34 MultiView™ tastenkombinationen

Tastenkürzel auf der Computertastatur 22



23 Tastenkürzel auf der Computertastatur

TI-30X Pro MathPrint™ or TI-30X Plus MathPrint™

Beispiel: Um den Bildschirm „Mode“ (Modus) im Emulator anzuzeigen, drücken Sie
entsprechend der nachstehenden Tabelle auf der Computertastatur die Taste [W].

TI-30X Pro MathPrint™ tastenkombinationen:

TI-30X Plus MathPrint™ tastenkombinationen:



*Hinweis:

Drücken Sie auf der MAC-Computertastatur

- [Delete] fürJ.
- [Backspace] für-.

Tastenkürzel auf der Computertastatur 24



25 Tastenkürzel auf der Computertastatur

TI-30X Prio MathPrint™

Beispiel: Um den Bildschirm „Mode“ (Modus) im Emulator anzuzeigen, drücken Sie
entsprechend der nachstehenden Tabelle auf der Computertastatur die Taste [W].

TI-30X Prio MathPrint™ tastenkombinationen:



*Hinweis:

Drücken Sie auf der MAC-Computertastatur

- [Delete] fürJ.
- [Backspace] für-.
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27 Tastenkürzel auf der Computertastatur

TI-30XS/30XB MultiView™

Beispiel: Um den Bildschirm „Mode“ (Modus) im Emulator anzuzeigen, drücken Sie
entsprechend der nachstehenden Tabelle auf der Computertastatur die Taste [W].

TI-30XS MultiView™ tastenkombinationen:



*Hinweis:

Drücken Sie auf der MAC-Computertastatur

- [Delete] fürJ.
- [Backspace] für-.
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29 Tastenkürzel auf der Computertastatur

TI-34 MultiView™

Beispiel: Um den Bildschirm „Mode“ (Modus) im Emulator anzuzeigen, drücken Sie
entsprechend der nachstehenden Tabelle auf der Computertastatur die Taste [W].

TI-34 MultiView™ tastenkombinationen:



*Hinweis:

Drücken Sie auf der MAC-Computertastatur

- [Delete] fürJ.
- [Backspace] für-.

Tastenkürzel auf der Computertastatur 30



31 Allgemeine Informationen

Allgemeine Informationen
Online-Hilfe
education.ti.com/eguide

Wählen Sie Ihr Land, um weitere Produktinformationen zu erhalten.

Kontaktaufnahme mit dem TI Support
education.ti.com/ti-cares

Wählen Sie Ihr Land, um technische und weitere Unterstützung zu erhalten.

Service- und Garantieinformationen
education.ti.com/warranty

Wählen Sie für Informationen zur Dauer und den Bedingungen der Garantie bzw. zum
Produktservice Ihr Land aus.

Eingeschränkte Garantie. Diese Garantie hat keine Auswirkungen auf Ihre gesetzlichen
Rechte.

Texas Instruments Incorporated

12500 TI Blvd.

Dallas, TX 75243

https://education.ti.com/eguide
https://education.ti.com/ti-cares
https://education.ti.com/warranty
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